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1. Introduction 
 
For polycrystalline or powder Transmission Electron Microscopy (TEM) specimens, electron 
diffraction ring patterns are widely employed for phase identification, where each diffraction 
pattern serves as a unique fingerprint for a known phase. 
 
In the analysis of polycrystalline electron diffraction patterns, computer programs originally 
designed for powder X-ray diffraction can be adapted. One approach involves transforming 
electron diffraction ring patterns into integral intensity profiles as a function of scattering angle, 
enabling direct comparison with powder X-ray diffractograms. Alternatively, specialized 
computer programs utilize formulas for electron diffraction intensity to analyze raw or processed 
polycrystalline patterns. Integrated electron diffraction software often includes modules for 
simulating polycrystalline patterns, although direct comparison with experimental data for phase 
identification is rare. A dedicated computer program is crucial for efficiently and accurately 
performing this task. 
 
The first version of PolyCrystalline Electron Diffraction (JECP/PCED, Li 2004) was developed 
to address these needs. Subsequent versions, such as ProJECT/PCED2 (Li, 2010), introduced 
new features including Blackman’s theory for intensity calculation, models for out-of-plane and 
in-plane texture matching, pseudo-Voigt functions for diffraction ring profiles, and 
improvements in pattern indexing and matching with experimental data. PCED2 integrated with 
the Landyne launcher and ProJECT package, offering enhanced user interface and input/output 
capabilities compared to its predecessor. 

PCED3 introduced drag-and-drop functionality and enhanced image operations such as inversion, 
alignment, resizing, and rotation. PCED4 expanded capabilities to simulate two crystalline 
phases and implemented an indexing system for phase identification. 

The current version, PCED6, further enhances manipulation of experimental electron diffraction 
patterns and improves indexing labels on simulated patterns. It includes tools for labeling and 
preparing figures for publication, significantly enhancing ease of use, especially for phase 
identification tasks. The software is implemented in openJDK and optimized for performance, 
including code obfuscation for security. A license file is required to fully unlock PCED6.jar for 
loading new input data files; otherwise, the program operates in demo mode using default input 
files (Al and Mg). Licenses can be obtained from LANDYNE computer software 
(jlandyne@gmail.com). 
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2. Theory background 

The kinematic theory of electron diffraction is extensively covered in literature on texture 
analysis (e.g., Peng et al., 2004). In this theory, the electron atom scattering factor is derived 
from the X-ray atom scattering factor using the Mott-Bethe relationship. Alternatively, it can be 
directly obtained from a parameterized table of electron atom scatter factors (Peng et al., 1996), 
which is the method employed here. 

Following the electron diffraction geometry, the radius of the diffraction ring, R, can be related 
to the length of the reciprocal vector g(hkl) as 
 
 

𝑅𝑅 =
𝐿𝐿𝜆𝜆
𝑑𝑑

�1 − � 𝜆𝜆2𝑑𝑑�
2

1 − 2 � 𝜆𝜆2𝑑𝑑�
2 

 
(1) 

 
Where L is the camera length, d=1/|g(hkl)| and 𝜆𝜆 is the wavelength of the incident electron beam. 
 
The integrated intensity of reflections in the electron diffraction from the polycrystalline sample 
was derived in the book by Vainshtein (1964). 
 
 

𝐼𝐼 = 𝐼𝐼0𝑉𝑉𝑉𝑉2𝑝𝑝
𝐹𝐹ℎ𝑘𝑘𝑘𝑘2

𝑣𝑣𝑎𝑎2
𝑑𝑑ℎ𝑘𝑘𝑘𝑘

2
 

 (2) 

 
Here V is sample volume, λ is the wavelength, p is a multi-factor, Fhkl is diffraction amplitude, 
the va is the volume of unit-cell, dhkl is the (hkl) spacing. 
 
2.1 Blackman’s theory on the intensity of polycrystalline electron diffraction 
 
Blackman’s theory (Blackman, 1939) for polycrystalline electron diffraction intensity is rooted 
in the Bloch wave dynamic theory initially formulated by Bethe. It provides formulas for the 
integral intensity of two-beam dynamic diffraction. According to Peng et al. (2004), Blackman’s 
theory represents an advanced approach in the field, despite its publication several decades ago. 
For detailed derivations of the formulas, readers are encouraged to consult the original paper. 
Below are some essential formulas: 
 
The dynamical structure factor is given, 
 

𝑈𝑈𝑔𝑔 =
2𝑚𝑚𝑚𝑚𝑉𝑉𝑔𝑔
ℎ2

 
 

 
(3) 

 Where m is electron mass, e is the electron charge, h is Planck constant, Vg is Fourier coefficient 
of crystal potential. 
 
The wave vector in a vacuum is given, 
 𝐾𝐾02 =

2𝑚𝑚𝑚𝑚𝑚𝑚
ℎ2

  
(4) 
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Here E is the accelerated voltage of the electron microscope. 
 
The wave vector inside the crystal is corrected with the mean inner potential, 
 
 𝐾𝐾2 = 𝐾𝐾02 + 𝑈𝑈0 

 
(5) 

 
The diffraction intensity formulas can be given below in an integrated form considering there are 
angle distribution between the incident beam and the zone axis of the polycrystalline grains, 
  
 

𝐼𝐼𝑔𝑔
𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 = 𝐼𝐼𝑜𝑜
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𝑔𝑔𝐾𝐾2 � 𝐽𝐽0(2𝑥𝑥)𝑑𝑑𝑑𝑑

𝐴𝐴

0
  

 

  
(6) 

Where 𝐼𝐼0  is the intensity of the incident beam, 𝑈𝑈𝑔𝑔  is dynamical structure factor, 𝐾𝐾 is a wave 
vector and 𝐽𝐽0(𝑥𝑥) the zero-order Bessel function and, 
 
 

𝐴𝐴 =
𝜋𝜋𝜋𝜋𝑔𝑔𝑡𝑡
𝐾𝐾𝑛𝑛 

 

 

 
(7) 

Here  𝐾𝐾𝑛𝑛 is K normal component and 𝐾𝐾2 = 𝐾𝐾𝑛𝑛2 + 𝐾𝐾𝑡𝑡2 (𝐾𝐾𝑡𝑡 is K component in the zero-order Laue 
zone). 
The final intensity is an averaged integral intensity over 𝐾𝐾𝑛𝑛, considering the angle between the 
incident beam and the surface normal in a range from  −𝜋𝜋

4
  to  𝜋𝜋

4
 . 

 
2.2 Pseudo-Voigt function for peak profile  
 
While the Voigt (V) function, a convolution of Gaussian (G) and Lorentzian (L) functions, is 
considered the most accurate for describing diffraction ring profiles, it is quite complex. As an 
alternative, the pseudo-Voigt (pV) function is commonly used, which is a linear combination of 
Gaussian and Lorentzian functions. According to Li (2007), 
 
 𝐺𝐺(𝑥𝑥) = ℎ𝑒𝑒𝑒𝑒𝑒𝑒(−4𝑙𝑙𝑙𝑙2(

𝑥𝑥 − 𝑥𝑥0
𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹

)2) 
 

(8) 

 
𝐿𝐿(𝑥𝑥) =

ℎ

1 + 4( 𝑥𝑥 − 𝑥𝑥0
𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹)2

 
 
(9) 
 
 

 𝑝𝑝𝑝𝑝(𝑥𝑥) = 𝜂𝜂𝜂𝜂(𝑥𝑥) + (1 − 𝜂𝜂)𝐿𝐿(𝑥𝑥) (10) 
 
Here h is peak height, x0 is peak position, FWHM is full width at half maximum. Figure 1 shows 
the comparison of profiles of Gaussian and Lorentzian functions. 
 
2.3 March Model for polycrystalline texture  
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In powder samples, axially symmetric platy or capillary specimens composed of effective disk- 
or rod-shaped crystallites can exhibit textures influenced by their shape. Thin film samples often 
develop polycrystalline microstructures with preferred orientations either out-of-plane or in-
plane during growth. Diffracted intensities from these orientations can be corrected or measured 
using a single pole-density profile. 

For correcting powder X-ray diffraction affected by texture, the March model is commonly 
applied. This model, known for its simplicity and effectiveness, addresses both out-of-plane 
(platy) and in-plane (rod) textures. 

 
Figure 1. Comparison of profiles of Gaussian and Lorentzian functions. 

 
The formulas were initially developed for X-ray powder diffraction and have been adapted for 
polycrystalline electron diffraction, considering the specific diffraction geometry of electron 
diffraction. Figure 2 illustrates example curves of the March functions used in X-ray powder 
diffraction (Bragg-Brentano geometry) and in polycrystalline electron diffraction for platy (out-
of-plane) texture. The preferred zone axis density for polycrystalline electron diffraction, as 
described in Dollase (1986) (refer to Figure 1 in that paper), can be formulated as follows: 
 
For out-of-plane texture,  
 𝑃𝑃𝑔𝑔(𝑂𝑂) = 𝑃𝑃𝐺𝐺(𝛼𝛼) = (𝑟𝑟2𝑠𝑠𝑠𝑠𝑠𝑠2𝛼𝛼 + 𝑟𝑟−1𝑐𝑐𝑐𝑐𝑐𝑐2𝛼𝛼)−

3
2 

 

 
(11) 

 
For in-plane texture, 
 

𝑃𝑃𝑔𝑔(𝑂𝑂) = 𝑃𝑃�𝐺𝐺(𝛼𝛼) = 2
𝜋𝜋� 𝑃𝑃𝐺𝐺(𝛼𝛼,𝛽𝛽)𝑑𝑑𝑑𝑑

𝜋𝜋
2

0
 

 
(12) 

 
If the axial pole-density profile, 𝑃𝑃(𝜑𝜑) is known, 𝑃𝑃�𝐺𝐺(𝛼𝛼) maybe obtained by numerical integration 
making use of the relation among coordinates: 𝜑𝜑 = cos−1(sin𝛼𝛼 cos𝛽𝛽). 
The intensity of polycrystalline electron diffraction including texture can be expressed as,  
 



7 
 

 
𝐼𝐼𝑔𝑔
𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟 = 𝑠𝑠�𝑃𝑃𝐺𝐺(𝛼𝛼𝑖𝑖)

𝑚𝑚

𝑖𝑖=1

𝐼𝐼𝑔𝑔
𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 

 
(13) 

 

 
Figure 2. Example curves of the March functions used in X-ray powder diffraction (Bragg-
Brentano geometry) and polycrystalline electron diffraction for platy (out-of-plane) texture. 
Angle away from the preferred orientation is in abscissa and the density (or weight) inordinate.   
 

 
Figure 3. Snapshot of the primary interfaces of   PCED, a simulation of polycrystalline electron 

diffraction in a two-phase system, Al and Mg.  
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Figure 4. Snapshot of the primary interfaces of   PCED, a phase identification using calculated 

polycrystalline electron diffraction pattern. The experimental PCED pattern is Al.  
 
Where s is the scale factor, Pg(αi) represents the density of g(hkl) poles at the scattering vectors, 
and αi denotes the angle between G(HKL) and the i-th member of the symmetry-equivalent set of 
m diffraction planes. The preferred orientation plane itself belongs to a set of symmetry-
equivalent planes. If the dominant morphological feature of the crystallites is re-indexed as 
another member of this set, the individual values of αi in the above equation will be permuted, 
but the sum of terms remains unchanged. This sum can be interpreted as a generalized 
multiplicity term. 
 
3.  The graphic user interface of PCED 
 
3.1 Main interface 
 
The main interface of PCED6 is depicted in Figures 3 and 4, featuring both a menu and a toolbar 
for input parameter selection, and a frame to display simulation outputs. To simulate diffraction 
patterns using PCED6, users need to load structure data and configure input parameters, then 
simply click the "Run" button in the Calculation dialog (as shown later). For phase identification 
tasks, PCED6 requires loading experimental diffraction patterns first, followed by matching 
them with calculated patterns. The software supports loading two sets of structure data 
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simultaneously for comparison or simulation of two-phase systems. Users can adjust the 
software's frame size, including the display panel, through the Auxiliary menu. 

3.2 Menu and toolbar 
 
Menu and toolbar can be used to pop up dialogs for data and parameters. The toolbar can also be 
hidden. Most functions of the menu and toolbar are the same; some functions are only provided 
either in the menu or in the toolbar, e.g., the drag-and-drop box for loading EDP in formats of 
JPEG, PNG and TIFF. 
 
Crystal menu provides an interface for preparing the new crystal data for loading the crystal 
data for phase 1 and phase 2. The file name can be viewed on the Parameter table in a dialog.  
 
Experiment menu provides an interface to load experimental polycrystalline electron diffraction 
(PCED) pattern in JPEG, PNG and TIFF format. The loaded PCED pattern can be inverted the 
grey color and can also be erased. The pattern can be resized and rotated for the best display. The 
pattern can be shifted to view the scale bar and make the calibration of the simulation using a G-
spacing marker. The pattern can be shown in full or half mode. The file name can be displayed or 
hidden.  
 
Simulation menu provides a submenu for the choice of electron diffraction theories and several 
dialogs (e.g., average grain size, peak profile, texture model) for input parameters in the 
simulation. Two theories are used for the calculation of electron diffraction intensity. The 
kinematical theory is selected by default, and the second choice is Blackman’s theory, which is 
an integral two-beam dynamic theory. Intensities calculated by Blackman’s theory are more 
accurate than those calculated by kinematical theory, but the calculation of dynamic theory will 
take a longer time. A dialog of an index label is used to adjust the position and font size of the 
index. The conversion tool is for Miller and Miller-Bravais index for a hexagonal system. A 
dialog of parameter-table is used for monitoring the parameters in the calculation.    
 
The pattern menu provided the output of the simulated patterns, the hkl intensity list, the 
preference of the hkl-inten list file, and print to a printer or a PDF file when a PDF print driver 
was installed. 
 
Options menu provides the look-and-feel provided by Java; an option to hide or show toolbar; 
freedom of customizing the appearance of simulated pattern; for example, the diffraction peak 
and ring color, the curve or solid profile; set the reciprocal spacing for a marker. 
 
The help menu provides a tool to find the current driver and its serial number (S.N.), a table of 
space group numbers and symbols, version information.  
 
4. Usage of PCED 
 
The recommended way is to use Landyne launcher. In the following, we show step by step from 
preparing structure data file, common routine usage for simulation, and to the last steps of saving 
and printing the results. More details on specific topics are left in the next section.  
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4. 1 Prepare new crystal structure file 
 
A structure data file can be prepared using the New Crystal Structure File dialogue window in 
Figure 5. The dialogue window provides an automatic assistant for the user and makes sure to 
meet the requirement of the file format. The template is embedded with the 230 space groups in 
the Hermann-Mauguin notation, which list in the international table for crystallography. 
However, only b unique axis will be used in a monoclinic system. Two origin choices can be 
accepted as input parameters, but choice-2 will be converted to choice-1. To save the data 
structure, click the Save button; or make a new one click the New button.  
 
 

 
Figure 5. Snapshot of the preparation of the new crystal structure file.  

 
The crystal file can be also converted from previous data for modification or from a 
crystallographic information file (CIF). If a data file in an alternative setting of space group for 
triclinic, monoclinic and orthorhombic systems is used, please click on the alternative settings 
(1~74). A tool for the transformation of files from the nonconventional notations to the standard 
notations is provided.  
 
4.2 Simulation 
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The kinematical theory is used as a default selection in the simulation since it is fast and fewer 
input parameters are required. Integral dynamical two-beam theory (Blackman’s theory) can be 
turned on using the Theory submenu in the Simulation menu.  
 
Basic parameters for calculation and adjustment of the diffraction pattern can be filled in or 
changed in the Calculation dialog in Figure 6. To generate new 
diffraction pattern needs, click the Run button. The pattern is 
automatically updated, corresponding to the change of other 
parameters.  
 
Mass ratio defines relative masses of the two phases when the fields 
of phase1 and phase2 are checked.  
 
Volume ratio defines relative volumes of the two phases when the 
fields of phase1 and phase2 are checked.  
 
g-spacing zoom and Intensity scale simulated the camera length and 
the exposure time in the experiment, which is used to make a better 
appearance of the calculated pattern.  
 
Peak type can be chosen from the integral intensity on a ring or 
intensity on unit-arc-length. 
 
The diffraction diagram can be viewed as peak and profile  
separately or together. 
  
Diffraction rings can be viewed as either a ring to match the 
experiment pattern or only the top half in order to clearly show the 
index without intervening or without a ring at all. 
 
The diffraction ring's appearance is also controlled by the profile 
intensity (intensity threshold).   
 

Figure 6. Snapshot of the calculation dialog.  
 
4.3 Index and intensity label 
 
There are cases where diffraction peaks are quite dense; the index labels may be overlapped 
when they are shown by the side of the diffraction diagram, especially for the diffraction diagram 
of the two-phase system. It is essential to allow users to adjust the positions of the index (and 
intensity) labels. 
 
To avoid the situation, PCED is allowed to select the location of an index label and to spread it 
when necessary. In the Index Label dialog, a top point can be viewed when the checkbox of the 
Top point is selected and moved around with mouse drag-and-drop. Dash line can be viewed 
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when the Baseline’s checkbox is selected and moved up/down by the mouse wheel or the arrow 
keys (after clicking the panel). 

Figure 7 illustrates the process of adjusting the positions of index labels using the Label dialog, 
which includes the following functionalities: 

• Remove weak peaks: Allows removal of indexes for weak diffraction peaks by adjusting 
the intensity threshold (arbitrary unit). 

• Position adjustment: To adjust index label positions: 
o Select either phase 1 or phase 2. 
o Check the "Index" box for the phase selected. 
o Check the "Guidelines" box for reference lines (optional). 
o Choose between "Top point" or "Baseline" for alignment. 
o Use drag-and-drop operations with the mouse pointer to move index labels to 

desired positions. 
• Font size: Set the font size independently for phase 1 and phase 2. 
• Link lines: Toggle link lines on or off as needed. 

 
Figure 7. Example for the Label adjustment. Snapshot of the Label adjustment dialog.  

 

4.4 Phase Identification 
 
It is easy to make a phase identification using PCED. An experimental PCED pattern and the 
crystal data of the possible phases are needed. The PCED pattern is in JPEG (.jpg), PNG (.png) 
or TIFF (.tif) formats, which can be quickly loaded using the window file system in a menu or 
the drag-and-drop box in the graphic menu bar. The PCED pattern can be processed, such as 
resize, rotate, and center, as shown in Figure 8. The scale-bar on the PCED pattern can be used 
for calibration of the G-spacing zoom in Figure 9. The PCED pattern can be displayed in full or 
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half size. The simulation of the possible phases is then calculated on the right side of the pattern 
panel if the positions and intensities of the diffraction rings are matched in agreement with the 
experimental PCED pattern.  

 
Figure 8. Snapshot of the image operation, such as alignment, resize, and rotation.  

 

 
Figure 9. Snapshot of the G-spacing marker. 

 
Phase identification is made; otherwise, the next possible 
phase is loaded for a check until all possible phases are run 
out.  
 
For the hexagonal system, the index can be the three-index 
Miller notation or the four-index Miller-Bravais notation. 
Three-index Miller notation is used in the PCED. A tool for 
converting the Miller notation and Miller-Bravais notion is 
also provided, as shown in Figure 10. 

 
Figure 10. Snapshot of the Hexagonal system index.  

 
4.5 Output for publication 
 
Calculated diffraction data can be saved into a file using Save in File menu, in which it includes 
hkl and intensity (per unit-length) together with the parameters used in the simulation as a 
default option. More info, such as length of a reciprocal vector (g), crystalline plane spacing (d), 
intensity (per unit angle), can be chosen to be saved by using selection in hkl-inten dialog in the 
options menu.   
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Simulated diffraction patterns and preloaded experimental patterns can be saved as output files in 
JPEG, PNG, or TIFF format. The output size can be selected according to the region of interest 
(ROI) and the point per inch (PPI). A tool for figure label is available, so the figure in one-step to 
be used for publication. An example figure and the tool for the figure label are shown in Figure 
11. 
 

 
Figure 11. Snap-shot of output and a tool for figure label. 

 

 

Figure 12. Snapshot of experimental pattern processing, resize, rotation, and center.  
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5. Special topics on PCED 
 
5.1 Partial occupancy factor and isotropic temperature factor 

In crystalline structures, some atom coordinates may not be fully occupied. In such cases, the 
occupancy factor (default value 1.0) should be adjusted according to the specific crystalline 
structure when preparing data files for polycrystalline electron diffraction simulations. 

Partial occupancy factors can also be employed to simulate varying degrees of chemical order 
within a structure. For instance, in the case of the chemically ordered FePt L10 phase (see 
section 6), different types of atoms may share the same atomic coordinates with different 
occupancy factors based on their chemical ratio. Notably, the sum of the occupancy factors for 
these atoms always equals 1.0. 

The isotropic temperature factor is utilized to model the effects of lattice vibrations, following 
the Debye model. While this model is a simplified approximation, it effectively simulates the 
decrease in diffraction intensity as the absolute value of the scattering vector |g| increases. Higher 
values of |g| correspond to greater reductions in diffraction intensity. 

5.2 Load and center EDP  

For phase identification, the experimental polycrystalline electron diffraction pattern must be 
loaded and compared with simulated patterns calculated from related phase files. The 
experimental pattern should be in JPEG, PNG, or TIFF formats. You can load the experimental 
pattern using the "Load" option in the Experiment menu or by using the drag-and-drop feature. 
After loading, you can resize, rotate, or center the pattern. 

To center the pattern precisely, use the "Shift & Center" function. This action will display 
concentric circles on the main panel. Click and hold the left mouse button to drag the pattern to 
the desired center position within the panel (refer to Figure 12). Click "Shift & Center" again to 
lock the PCED pattern in place and hide the concentric circles. Fine adjustments may be 
necessary to achieve the exact positioning. You can adjust the number of concentric circles 
displayed using the "Number of Reference Circles" option. 

5.3 Peak profile, incident beam, and texture 

The profile of the diffraction ring's cross-section, known as the peak profile, can be simulated 
using a pseudo-Voigt function along with parameters like grain size (diameter) and a constant K. 
The ratio of Gaussian and Lorentzian functions in the pseudo-Voigt function can be adjusted 
using the "Peak Profile" option found in the Simulation menu (default value is 0.5). 

To further refine the simulation, you can adjust the grain size (diameter) and the constant K 
using the "Average Grain Size" dialog in the Simulation menu. 

In polycrystalline electron diffraction, the incident beam is often much stronger compared to the 
diffraction rings, potentially obscuring weaker rings near the incident beam. To address this, the 
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incident beam can be included in the simulated pattern by checking the "Included" box in the 
Peak Profile dialog. You can then adjust its shape by modifying the corresponding height and 
full width at half maximum (FWHM) values. 

You have the option to select the peak and profile individually, and the style of the profile can be 
chosen between solid shadow or curve representations. 

5.4 Parameter table 

In the texture dialog of PCED6, you can input the axis of texture and the March parameter 
(default value 1.0 for full randomness). These values can be separately set for phase 1 and phase 
2. 

The March parameter r is used to quantify the degree of randomness in polycrystalline or powder 
samples. A higher value of r indicates better approximation to randomness. Conversely, to 
describe the level of preferred orientation, we suggest using the reversed March parameter 
r′=1.0−r. Thus, r′=0 represents full randomness, and higher values of r′ indicate stronger 
preferred orientation, with r′=1.0 representing perfect alignment. 

To facilitate tracking and management of simulation parameters, you can use the "Parameter 
Table" option in the Simulation menu. This table lists essential parameters for both phase 1 and 
phase 2, providing convenience in parameter management during simulations. 

5.5 Determine the weight ratio of a two-phase system 

PCED6 offers a method to simulate the composite diagram of a two-phase system with a 
specified weight ratio. The program utilizes a formula to convert the weight ratio into the 
numbers of unit cells in diffraction, using the atomic weight per unit cell for each phase for 
simplicity. 

To experimentally determine the weight ratio of a two-phase system, calibration using a standard 
sample with a known weight ratio is essential. This calibration ensures accurate interpretation 
and simulation of diffraction patterns in PCED6. 

5.6 Grain size and the FWHM of diffraction ring 

PCED6 provides a method to simulate the Full Width at Half Maximum (FWHM) of diffraction 
rings based on a given average grain diameter and K factor. The FWHM values for each ring in 
the calculated diagram are consistent with the pseudo-Voigt function used in the simulation. 

In experimental diffraction patterns, the diffraction rings often consist of individual spots from 
grains with varying grain sizes. The peak profiles are determined by summing data around each 
ring. Therefore, different pseudo-Voigt functions may be required to fit the peaks of each ring 
accurately. 
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The grain size does not directly influence the peak profiles of polycrystalline electron diffraction 
ring patterns in a straightforward manner. Grain size measurements are typically conducted using 
bright field or dark field imaging methods. 

6. Examples 
 

6.1 Phase identification of the Cr-N thin films  

According to the phase diagram of the Cr–N system (Venkatraman & Neumann, 1990), the Cr2N 
phase is stable within a nitrogen composition range of approximately 27.5–33 at. %, while the 
CrN phase has a very narrow equilibrium range of 47.5–50 at. % N. CrN crystallizes in a face-
centered cubic (f.c.c.) structure with a lattice parameter of a=0.414 nm, whereas Cr2N adopts a 
hexagonal structure with lattice parameters a=0.4752 nm and c=0.4429 nm (Villars & Calvert, 
1985). 

 
Figure 13. Comparison of calculated polycrystalline electron diffraction patterns of  

(a) f.c.c. CrN, (b) hexagonal Cr2N and (c) b.c.c. Cr, with intensities  
(b) on top and indices at the bottom of each peak.  

Cr–N thin films have been extensively investigated as important coating materials. Our research 
on Cr–N films originated from the study of Cr-doped AlN (AlCrN), a system known for its 
ferromagnetic semiconductor properties. To ascertain the origin of ferromagnetism, it was 
crucial to exclude contributions from any potential second phases in AlCrN, such as CrN and 
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Cr2N. Therefore, detailed studies were conducted on the structure and properties of Cr–N films 
(Li et al., 2004). 

Cr–N films were deposited on Si (001) substrates by reactive magnetron sputtering under an 
N2/Ar atmosphere at room temperature. The composition of the films, denoted as Cr1-xNx, was 
varied by adjusting the N2/Ar pressure ratio during the synthesis process. Two batches of thin 
films were prepared with different N2 partial pressures: sample 1, P(N2) = 5 x 10-1 Pa and sample 
2, P(N2) = 5 x 10-3 Pa. 
 
Simulation of the polycrystalline electron diffraction patterns from CrN and Cr2N and Cr 
 
Figure 13 displays the simulated polycrystalline electron diffraction patterns for (a) face-centered 
cubic (f.c.c.) CrN phase (Villars & Calvert, 1985), (b) hexagonal Cr2N phase (Kim et al., 1990), 
and (c) body-centered cubic (b.c.c.) Cr phase. The calculated patterns illustrate the 
distinguishable features of CrN, Cr2N, and Cr phases in polycrystalline electron diffraction. 
 

 
Figure 14. Experimental polycrystalline electron diffraction patterns of thin films produced (a) 
with N2 partial pressure P(N2) = 5 x 10-1 Pa and (c) with N2 partial pressure P(N2) = 3 x10-3 Pa. 

Simulated patterns (b) based on the cubic CrN structure and (d) based on the cubic CrN structure 
with half occupancy of N sites. 

 
Thin films produced with different N2 partial pressure 

Figure 14 presents the following: (a) a polycrystalline electron diffraction pattern from sample 1 
and (b) a simulated pattern based on the structure of the face-centered cubic (f.c.c.) CrN phase. 
The agreement in both ring radii and relative intensities confirms that the microcrystalline phase 
in sample 1 is indeed the f.c.c. CrN phase. Figure 14(c) displays a polycrystalline electron 
diffraction pattern from sample 2. The simulated patterns (see Figs. 13b and 13c) corresponding 
to the hexagonal Cr2N phase and b.c.c. Cr do not match the experimental pattern. While the ring 
radii in the experimental pattern are similar to those in Fig. 14(a), the relative intensities differ. 
Hence, the microcrystalline phase in sample 2 likely shares the same or very similar unit cell and 
lattice parameters as sample 1. 
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Given that sample 2 was synthesized under a lower N2 partial pressure compared to sample 1, 
we attempted to interpret Fig. 14(c) using the structure of cubic CrN phase with vacancies at N 
sites. A simulated pattern (Fig. 14(d)) calculated with the structure of cubic CrN phase featuring 
half-occupancy at N sites demonstrates a significant increase in intensity of the innermost ring, 
while other rings show minimal intensity changes. This simulated pattern in Fig. 14(d) 
effectively matches the experimental one in Fig. 14(c), suggesting that the microcrystalline phase 
in sample 2 can be identified as cubic CrN phase with vacancies at N sites. 

6.2 Analysis of thin films with FePt L10 phase   

To enhance the areal density of magnetic recording media, reducing the grain size of magnetic 
films is crucial. Achieving a high-anisotropy material is essential for ensuring thermal stability in 
the new media. The FePt L10 phase stands out due to its high anisotropy energy, making it a 
promising candidate for magnetic recording applications. Initially, as-deposited FePt films 
typically exist in a disordered face-centered cubic (fcc) phase, which is magnetically soft. 
However, through suitable annealing treatments, this phase can be transformed into the ordered 
L10 phase. 

The chemical ordering within the L10 phase is influenced by the film's composition and the 
specific conditions during heat treatment. For optimal data-storage applications, it is 
advantageous for the [001] axis of the L10 phase to be oriented perpendicular to the film plane. 
This orientation is favored because the [001] axis of the L10 phase represents an easy magnetic 
axis, ensuring efficient magnetic recording. 

One effective method to achieve the desired (001) texture involves depositing a multilayer of Fe 
and Pt films followed by annealing at elevated temperatures. Researchers have focused on 
understanding the formation of (001) texture across various ranges of film thicknesses to 
optimize magnetic properties for practical applications. This approach aims to control the growth 
and orientation of grains within the film, thereby enhancing magnetic performance and stability 
in magnetic recording media. 

 
Figure 15. SAED pattern of the FePt L10 phase in a film with a thickness of 20 nm annealed at 

600 °C for 30 seconds and calculated pattern for phase identification. 
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Figure 16. SAED pattern of the FePt L10 phase in a film with a thickness of 4 nm annealed at 

600 °C for 30 seconds and calculated pattern with (001) texture. 
 
FePt film with a thickness of 20 nm  
 
Figure 15 shows the SAED pattern of FePt film with a thickness of 20 nm annealed at 600 °C for 
30 seconds and the calculated pattern of the FePt L10 phase-in for phase identification. The ring 
radiuses and corresponding intensities in the calculated pattern are considered to match well with 
the experimental pattern. On the other hand, the ring radiuses and corresponding intensities in the 
calculated pattern with FePt fcc polycrystals (not shown here) do not match the experimental 
pattern. Thus, the phase is confirmed to be the chemical ordered FePt L10 phase.  
 
FePt film with thickness 4 nm 
 
The radius step of the diffraction patterns in Figure 15 is the same as those in Figure 16; however, 
the intensity distributions of the diffraction patterns are dramatically different. Now we estimate 
the (001) texture of the film with a thickness of 4 nm semi-quantitatively.   
 
Fig.17 is a processed digital diagram of Fig.16 using a program QPCED (Li, 2007). Using March 
parameters of 0.45 and a given chemical order (Pt sites with 80%Pt+20%Fe; Fe sites with 
80%Fe+20%Pt), a calculated diagram in Fig.18 is best matching with Figure 17 is obtained. As 
discussed in section 5.3, if we use revised March (0.0 for full random and 1.0 for perfect texture), 
the texture can be described as 55% of the (001) texture.  
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Figure 17. Digital processed diagram of the experimental electron diffraction pattern in Figure 17. 

 
Figure 18. A simulated diffraction diagram fitting to Figure 18 reveals the degrees of chemical 

order and (001) texture of film with a thickness of 4nm. 
 

7. Installation of PCED 
 
7.1 Installation 
  
Download and install the most recent openJDK from the internet. Download 
(https://landyne.com) and decompress the Landyne6 package. Copy the license to the programs\ 
subfolder.   
 
7.2 PCED in Landyne suite  
 
Click the PCED in Landyne launcher to start the software. 
 
7.3 License   
 
A license file is needed to unlock the program (PCED.jar) for simulating PCED patterns. The 
program may run in demo mode, which works in full functions but limits to the given crystal 
files. A license is available from LANDYNE (computer software and graphic design).  
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